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Abstract: A number of commercial software packages are currently available to perform digital two-dimensional electrophoresis
(2D-GE) gel analysis. However, both the high cost of the commercial packages and the unavailability of a standard data analysis
workflow, have prompted several groups to develop freeware systems to perform certain steps of gel analysis. Unfortunately, to the
best of our knowledge none of them offer a package that performs all the steps envisaged in a 2D-GE gel analysis. Here we describe an
ImagelJ-based procedure, able to manage all the steps of a 2D-GE gel analysis. Image] is a free available image processing and analysis
application developed by National Institutes of Health (NIH) and widely used in different life sciences fields as medical imaging,
microscopy, western blotting and PAGE. Nevertheless no one has yet developed a procedure enabled to compare spots on 2D-GE gels.
We collected all used ImageJ tools in a plug-in that allows us to perform the whole 2D-GE analysis. To test it, we performed a set of
2D-GE experiments on plasma samples from 9 patients victims of acute myocardial infarction and 8 controls, and we compared the
results obtained by our procedure to those obtained using a widely diffuse commercial package, finding similar performances.
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Introduction

Two-dimensional gel electrophoresis (2D-GE) is a
powerful technology to compare complex protein
mixtures; it has been applied to many fields of bio-
medical research and is widely used in biomarker
discovery. In a 2D-GE gel thousands of proteins are
separated in well defined spots; these protein spots
can be revealed via a variety of staining techniques
(Coomassie, Silver Stain, Sypro),' and captured by
one or more digitized computer images per gel(CCD
camera, laser scanner, and optical scanner).”? The
image capturing phase transforms the biological
information of the 2D-GE gel into a quantitative
computer-readable data set. Once all the studied
gels have been collected and digitized the software-
based image analysis can be started. Image analy-
sis 1s crucial in extracting biologically relevant
information from a two-dimensional gel electropho-
resis experiment.

Despite the availability of several software appli-
cations to analyze 2D-GE images, there is no gen-
eral consensus on 2D-GE data analysis protocol.
Moreover several authors reported that the commer-
cial packages are time consuming, can often miss
values or give false positives, and induce variance in
quantitative measures.>”’

The commercially available software perform the
analysis workflow in two different ways. The classical
package condensed the information onto spots. The
spot detection is performed prior to matching and
expression profile extraction. The second image
analysis software group is based on the whole image
information. These packages apply a warping pro-
cedure to remove running differences between gels,
and the spot detection and protein expression profiles
extraction occurred in a separated and independent
step.’ The emphasis in this analysis software has been
on reducing the subjectivity of the image analysis.

The fact that the alignment step is performed prior
to the spot detection facilitates simultaneous spot
detection on all gel images in an experiment and
the resulting spot boundaries are identical on all gel
images.'” In Table 1 are collected the most popular
commercial software for 2D-GE gel analysis.

Several research groups have developed freeware
systems to handle certain key aspects of gel analy-
sis, including archiving (SwissProt 2D),'" compari-
son (Flicker),"? interactive exploration (WebGel),'
registration (bUnwarpJ and Sili2DGel),'*!* spot
detection,'® spot quantification precision and differ-
ential expression (Pinnacle).!” However nobody has
developed a complete package freely available and
platform independent able to perform all the steps of
a 2D-GE gel analysis experiment.'®

Leveraging also on these experiences we have
developed an image analysis workflow based on
the popular public domain image analysis software
package ImagelJ (http://rsb.info.nih.gov/ij/). Imagel
and its plug-in is easy-to-use software and can be
used in routine applications. Our workflow has been
developed according to the whole image information
procedure.' It is based on six steps: aligning all the
images, computing image fusion, creating a consen-
sus spot pattern, propagating the consensus spot pat-
tern to all gel images for quantification, and finally
the statistic analysis.

In order to test our procedure, we performed a
2D-GE study of plasma from patients immediately
after an acute myocardial event, comparing the results
obtained using a widely diffused commercial package
(Melanie; GeneBio, Geneva)tothose obtained with our
ImagelJ-based procedure. We looked for biomarkers
of pathology and/or treatment in acute myocardial
infarction (AMI) patients treated with common anti-
coagulant protocols. The authors confirm that ethical
approval was obtained for this research.

Table 1. The most popular commercial software for 2D-GE gel analysis.

Software package Company Type Web link

PDQuest BioRad, Hercules, CA Spot based www.bio-rad.com
ImageMaster 2D or DeCyder GE Healthcare Spot based www.gehealthcare.com
Dymension Syngene, Cambridge, UK Spot based www.syngene.com
Melanie GeneBio, Geneva, Switzerland Spot based www.genebio.com
Delta2D Decodon, Greifswald, Germany Warping www.decodon.com
Progenesis SameSpots Nonlinear Dynamics, Newcastle, UK Warping www.nonlinear.com
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Table 2. List of steps that describes how to perform the analysis.

Step

Description

Web link

1

10

Download and install Imaged on your

computer following the installation instructions
specific to your platform (Windows, Mac OS,

Linux, etc.);

Align all images in pairs using bUnwarpd plugin and
taking always the same image as reference, and
save the warped images;

Open all the warped images and save these

in a stack as a sequence using the
“Image>Stacks>Images To Stack command”;

Sum image using “Image>Stacks>Z

Project...>Sum Slices”;

Perform spot detection on the fused image by the
Watershed plug-in. Selected the binary output;

Apply the blob analyzer of Imaged using “Analyze>
Analyze Particles...”, to measure the catchment
basins and save the blots as a list of ROI;

Open the stack image(saved in point 4) and propagated
to all gel images the list of ROI obtained in by the spot
detection procedure “ROI Manager>Show All’;
Measure the spots volume values using “ROI
Manager>Measure” and save the Results as
OpenOffice compatible (.ods) file;

For quantitative comparison of spot intensities choose
Integrated Density measure. This value is the integral
of all pixel intensities within the spot boundary;
Normalize the volume of each spot on a given gel
image versus the total volume of all spots on that
image, perform the ANOVA Test on normalized data.

http://rsbweb.nih.gov/ij/download.html

http://biocomp.cnb.uam.es/~iarganda/bUnwarpJ/

http://bigwww.epfl.ch/sage/soft/watershed/index.html

http://www.openoffice.org

Material and Methods

2-DE page

With this aim, we enrolled 9 patients admitted within
6 hours after the onset of chest pain symptoms, with
myocardial infarction defined according to ESC/
ACC criteria. All subjects signed informed consent
forms prior to standard sample collection. 2D-GE
was performed according to Maresca et al*® and each
sample was run in duplicate. For the first-dimension
electrophoresis of plasma samples 200 pg (approxi-
mately 3 pl) were applied to 18-cm linear IPG strips
4-7 GE Healthcare (Uppsala, Sweden) and focused
until 72000 V/hr were reached. Prior to SDS-PAGE,
the IPG strips were equilibrated twice for 15 min in
equilibration buffer (50 mM Tris-HCI pH 8.8, 6 M
urea, 30% (v/v) glycerol, 2% (w/v) SDS and traces of
bromophenol blue) containing 1% (w/v) DTT for the
first equilibration step and 2.5% (w/v) iodoacetamide
for the second step. SDS-PAGE was performed on
12.5% polyacrylamide gels according to Laemmli.!

The run was carried out at 60 mA/gel at 16 °C and
terminated when the dye front reached the lower
end of the gel. Gels of plasma samples were visibly
stained with Coomassie Blue, scanned using trans-
mission mode to avoid saturation effects and saved in
16-bit TIFF format.

Image analysis

Once all gels in the study had been collected and digi-
talized, they were analyzed using the ImageJ and some
of its plugins or the commercial software Melanie.

We now go through the ImageJ-based procedure,
and then we will compare the results obtained to the
Melanie output. In Table 2 is collected the list of
steps that describes how to perform the analysis using
ImageJ and its plug-in.

First, all images were warped by bUnwarpl,'* an
algorithm for elastic and consistent image registration
developed as an ImageJ plug-in. It performs a simulta-
neous registration of two images, allowing us to solve

Proteomics Insights 2011:4

39


http://www.la-press.com
http://rsbweb.nih.gov/ij/download.html
http://biocomp.cnb.uam.es/~iarganda/bUnwarpJ/

Natale et al

the problem of spatial distortions due to run-time
differences and dye-front deformations.

We used the software to align all images in pairs,
taking always the same image as reference and pro-
ducing the corresponding warped images of the
others. bUnwarpJ can be freely downloaded from
http://biocomp.cnb.uam.es/~iarganda/bUnwarpJ/.

The reference image and warped images were
subsequently displayed in a single stack image and
summed to generate a fused image. We followed an
image sum approach to retain as much information as
possible from the original images.

Spot detection was performed on the fused image
by the watershed plug-in written by Daniel Sage and
freely downloaded from http://bigwww.epfl.ch/sage/
soft/watershed/index.html. This plug-in is able to seg-
ment an image using the watershed algorithm by flood-
ing directly on graylevel image. Of the several kind of
outputs provided, we selected the binary output that
allows us to apply the blob analyzer of ImagelJ, so as
to measure the catchment basins and save the blots,
one for each protein spot, as a list of regions of inter-
est (ROI). Each ROI corresponds exactly to a spot in
the fused image. The list of ROI obtained by the spot
detection procedure was our consensus spot pattern
that is valid for the whole gel set of the experiment.

In other words, the list of ROI obtained is equivalent to
the grid used in gene chip analysis, this grid was imposed
on each of the aligned gel images so that a defined num-
ber of areas were quantified on every gel image of the
experiment. The spot volume values extracted from
each image were listed in a ImageJ “Results table”. The
resulting table of “the whole image information proce-
dure” did not have empty cells, while some commer-
cial software, such as Melanie, are not able to eliminate
all bias due to missing spot values.* All the data were
analyzed by Calc (OpenOffice), a open source spread-
sheet program downloadable from the web site http://
www.openoffice.org/. For the normalization the vol-
ume of each spot on a given gel image was diveded
by the total volume of all spots on that image.> The result-
ing table of our method did not have empty cells, while
some commercial software, such as Melanie, are not able
to eliminate all bias due to missing spot values.?

Results
The warping step has produced a good alignment of
all 2D-GE images. In Figure 1 is shown an example

M T

Figure 1. (A and B) shown two different 2D-GE images of two control
subjects. In (C) is shown the elastic registration obtained during using
bUnwarpJ plug-in. In Figure 1D is shown the overlap of the two gels after
the warping step, in the red channel is shown the reference gel (Fig. 1A)
and in the green channel is shown a warped gel.

of warping step results. Figure 1A and B show two
different 2D-GE images, in Figure 1C is shown the
elastic registration obtained during the warping, and in
Figure 1D the overlap of the two gels after the warping
step. For the image fusion process all the warped images
were used and the fused images do not show multiple
spots thanks to the strength of the elastic alignment.
Using the ImagelJ procedure we were able to study
232 conserved spots, while with Melanie we analyzed

Figure 2. 2D-GE from the plasma of a control individual. (A) Spots
detected and matched using Melanie. (B) Spots detected using the
ImagedJ procedure.

Note: The stars show the spots used for comparison of quantification
methods (unchanged spots in blue, differential spots in green).
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Figure 3. Scatter plot of spot mean volumes as evaluated by Melanie
and ImageJ.

Notes: The ImageJ values are plotted on the X-axis, the Malenie values
on the Y-axis. Spots were normalized based on total spot volume.

a pattern of 205 matched spots. The spot detection
and the matching were manually checked in both
the procedures; Figure 2 shows the spots detected by
the two procedure on one of the control subject gels
(the reference gel used for the Melanie analysis).

The scatter plot in Figure 3 shows that there is
a linear relationship between the spot volumes
evaluated by Melanie and the corresponding val-
ues obtained by the Imagel] procedure. In particu-
lar 42 spots, 33 more abundant spots (blue stars
in Fig. 2) and the 9 differentially expressed spots
(green stars in Fig. 2, see the next paragraph for
the identification procedure) were considered for
the comparison; the fact that the straight line in
Figure 3 has a slope <1 means that volume values
calculated for the same spot are on average larger
by using the Imagel procedure, which can be related
to the slightly larger area segmented for each spot
by ImageJ due to the fact that spots were segmented
on the fused image (and not on every single gel, as
Melanie does). Similar results were obtained for the
spot list of every other gel as well as for the average
volumes (data not shown).

The 9 differential spots (shown in Figure 4), whose
mean normalized volume was significantly decreased
in the myocardial infarction versus the control group,
were all identified by ¢ test (P-value <0.001); the
test was run independently on the list of the spots,
quantified by our procedure or by Melanie. 7 out

O Control

M Infarction

41 40 133 142 143 146 147 149 173

Figure 4. Profile of proteins differentially expressed in the plasma of myocardial infarction (MI) patients vs. control subjects. 7 spots were found significantly
decreased in the plasma of the myocardial infarction patients by both methods (P-value < 0.001 , ANOVA test). Spots 133 and 173 were found to be differ-
entially expressed by one method only (see text for explanation). Spots 142, 143, 146, 147 and 149 were identified as fibrinogen gamma chain fragments.

In supplementary materials is shown the table with all raw data of the spots.
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of the 9 spots were well above the selected P-value
threshold for both Melanie and the ImagelJ-based
procedure, while each of the 2 methods identified
an additional spot which was missed by the other
(with reference to Figure 4, spots 133 and 173 where
identified only by Melanie and ImageJ respectively).
These 2 spots have a P-value slightly higher than the
threshold and anyway with a significance under 0.05.
All data of the spots are shown in table in supplemen-
tary material.

By using the procedure described by Lemkin
et al,** ie, by matching the spots of a gel with those
of a reference map of human plasma (http://expasy.
org/swiss-2dpage/viewer), we were able to tenta-
tively identify 5 of the 7 significantly different spots
as fibrinogen gamma chain fragments (with reference
to Figure 4, spots 142, 143, 146, 147, and 148).

Discussion and Conclusions

Previous proteomic studies reported protein expression
differences in plasma from patients during an acute
coronary syndrome and from patients with moderate
hypercholesterolemia,” and proteomic differences
in the plasma of coronary ischemic patients resistant
to aspirin as compared to aspirin-sensitive patients.?
Interestingly, 3 of the very same gamma fibrinogen
spots were reported as increased in untreated myo-
cardial infarction,” but thrombolytic (fibrinolytic)
therapy reduces the level of all fibrinogen chains (see
for example?’). Since all the enrolled patients received
an anticoagulant therapy, this decrease is possibly con-
nected to the therapy, and thus may reflect modifications
of the fibrin/fibrinogen balance in the patient blood.

Further experimental work in a larger patient cohort
will be needed to confirm these data, and the study of
the effects of anticoagulant therapy on hospitalized
patients goes beyond the purpose of this work.

In conclusion, we have developed a free and easy
alternative to a common commercial package for the
segmentation and quantification of 2D gel spots; the
procedure proved to be so effective, to confirm the
results obtained by an established commercial solution.

We hope that the provided solution can help pro-
teomic laboratories to quickly and inexpensively eval-
uate 2D-gel experimental results, without losing the
required accuracy and providing a common reference
for future analyses.
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Supplementary Materials
The table shows the data obtained for ImagelJ based analysis. The spots in green have a P-value < 0.001 (these
spots are shown in Fig. 3). In yellow is shown the spot 173, this spot has a P-value < 0.05 in ImageJ analysis and
P-value < 0.001 in Melanie analysis (this spot is shown in Fig. 3).

Control Control Control Infarction Infarction Infartion T test Wilcoxon
mean St_Dev median mean St_Dev median P-value P-value
149 1.401 0.114 1.421 0.721 0.146 0.705 0.0000001 0
147 1.394 0.117 1.355 0.702 0.155 0.656 0.0000001 0
146 0.653 0.092 0.656 0.351 0.068 0.329 0.0000179 0
143 0.154 0.028 0.148 0.071 0.016 0.066 0.0000692 0
41 0.016 0.005 0.013 0.007 0.001 0.007 0.0001684 0
142 0.107 0.022 0.096 0.055 0.010 0.051 0.0004514 0
133 0.124 0.023 0.118 0.076 0.015 0.067 0.0006462 0
40 0.029 0.011 0.024 0.013 0.002 0.013 0.0009521 0
79 0.052 0.014 0.054 0.025 0.009 0.022 0.0020000 0.0020000
154 0.196 0.018 0.191 0.150 0.031 0.158 0.0020000 0.0020000
135 1.156 0.258 1.180 0.759 0.144 0.771 0.0050000 0.0040000
173 0.119 0.040 0.137 0.059 0.024 0.051 0.0060000 0.0120000
144 0.018 0.004 0.017 0.013 0.002 0.012 0.0070000 0.0000000
157 0.006 0.001 0.006 0.005 0.001 0.005 0.0070000 0.0060000
25 0.151 0.059 0.164 0.218 0.031 0.219 0.0250000 0.0120000
124 0.352 0.043 0.365 0.297 0.046 0.300 0.0260000 0.0320000
199 0.019 0.006 0.016 0.027 0.005 0.027 0.0260000 0.0320000
4 0.093 0.034 0.075 0.130 0.025 0.131 0.0340000 0.0420000
150 0.386 0.106 0.359 0.277 0.057 0.266 0.0390000 0.0080000
182 0.197 0.018 0.199 0.221 0.024 0.211 0.0430000 0.0900000
224 0.175 0.031 0.165 0.141 0.030 0.153 0.0450000 0.0420000
22 0.191 0.085 0.206 0.273 0.049 0.255 0.0490000 0.0540000
1 0.036 0.011 0.032 0.054 0.021 0.050 0.0550000 0.0720000
177 0.461 0.096 0.463 0.626 0.212 0.676 0.0610000 0.1420000
129 0.135 0.051 0.114 0.189 0.058 0.185 0.0660000 0.0720000
5 0.065 0.024 0.052 0.088 0.024 0.090 0.0780000 0.0900000
183 0.202 0.011 0.203 0.226 0.034 0.224 0.0800000 0.2100000
46 0.034 0.011 0.034 0.024 0.010 0.021 0.0810000 0.0420000
21 0.227 0.104 0.251 0.320 0.088 0.334 0.0820000 0.1740000
2 0.087 0.030 0.073 0.115 0.029 0.113 0.0830000 0.0900000
223 0.025 0.005 0.024 0.042 0.026 0.029 0.0860000 0.0220000
103 0.439 0.036 0.452 0.402 0.046 0.400 0.0950000 0.1420000
73 0.469 0.133 0.484 0.606 0.179 0.555 0.1030000 0.0900000
165 0.128 0.047 0.105 0.205 0.119 0.140 0.1040000 0.1140000
3 0.094 0.038 0.072 0.123 0.024 0.128 0.1090000 0.1740000
139 0.686 0.091 0.685 0.552 0.209 0.496 0.1110000 0.0900000
136 0.146 0.028 0.138 0.121 0.030 0.130 0.1140000 0.1740000
118 0.416 0.035 0.408 0.379 0.056 0.383 0.1220000 0.3000000
110 0.087 0.009 0.084 0.079 0.010 0.079 0.1280000 0.1420000
43 0.006 0.005 0.003 0.002 0.000 0.002 0.1300000 0.0120000
(Continued)
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(Continued)
Control Control Control Infarction Infarction Infartion T test Wilcoxon
mean St_Dev median mean St_Dev median P-value P-value
74 1.095 0.279 1.187 1.341 0.332 1.273 0.1300000 0.2520000
122 0.018 0.003 0.017 0.015 0.003 0.015 0.1300000 0.1140000
170 0.028 0.002 0.028 0.041 0.023 0.033 0.1340000 0.1420000
54 0.010 0.002 0.009 0.012 0.003 0.012 0.1360000 0.1140000
60 0.052 0.010 0.052 0.060 0.011 0.062 0.1360000 0.2100000
163 0.155 0.014 0.157 0.142 0.020 0.142 0.1420000 0.2100000
44 0.007 0.006 0.003 0.003 0.000 0.003 0.1480000 0.1140000
78 0.077 0.023 0.082 0.110 0.058 0.128 0.1480000 0.2100000
86 0.007 0.001 0.007 0.008 0.002 0.008 0.1540000 0.2100000
141 0.078 0.072 0.042 0.033 0.012 0.028 0.1540000 0.3520000
42 0.009 0.008 0.004 0.004 0.001 0.004 0.1570000 0.2520000
219 0.244 0.031 0.233 0.201 0.077 0.164 0.1570000 0.0720000
6 0.023 0.008 0.020 0.029 0.008 0.030 0.1590000 0.1740000
30 0.064 0.025 0.066 0.087 0.038 0.079 0.1590000 0.2100000
29 0.114 0.041 0.127 0.144 0.037 0.153 0.1610000 0.1740000
168 0.036 0.013 0.035 0.054 0.034 0.044 0.1660000 0.1420000
39 0.016 0.004 0.014 0.014 0.003 0.014 0.1730000 0.3520000
47 0.088 0.027 0.077 0.111 0.038 0.100 0.1740000 0.3000000
178 0.025 0.006 0.027 0.029 0.006 0.029 0.1780000 0.1740000
121 0.347 0.112 0.336 0.421 0.102 0.420 0.1970000 0.1740000
115 1.627 0.167 1.669 1.733 0.147 1.691 0.2090000 0.3000000
231 0.043 0.012 0.040 0.091 0.104 0.041 0.2120000 0.5360000
58 0.078 0.024 0.079 0.061 0.027 0.057 0.2130000 0.1740000
137 0.050 0.041 0.033 0.028 0.013 0.021 0.2140000 0.2520000
15 0.029 0.026 0.018 0.046 0.028 0.035 0.2170000 0.1740000
215 0.614 0.039 0.597 0.579 0.069 0.587 0.2200000 0.2520000
111 0.164 0.030 0.152 0.141 0.041 0.132 0.2280000 0.1740000
123 0.208 0.028 0.217 0.232 0.048 0.211 0.2340000 0.7580000
172 0.359 0.133 0.391 0.286 0.091 0.300 0.2370000 0.2520000
229 0.183 0.138 0.095 0.106 0.096 0.075 0.2380000 0.6060000
159 0.037 0.008 0.036 0.044 0.013 0.043 0.2410000 0.3000000
200 0.100 0.055 0.110 0.073 0.025 0.063 0.2490000 0.5360000
228 0.528 0.225 0.587 0.659 0.203 0.681 0.2500000 0.2100000
48 0.192 0.056 0.174 0.222 0.041 0.217 0.2580000 0.1740000
195 0.017 0.002 0.017 0.023 0.016 0.017 0.2590000 0.3000000
107 0.049 0.011 0.045 0.044 0.003 0.044 0.2650000 0.6800000
131 0.595 0.075 0.577 0.652 0.123 0.673 0.2700000 0.1140000
102 0.172 0.026 0.181 0.160 0.014 0.160 0.2710000 0.2520000
20 0.289 0.133 0.270 0.360 0.109 0.362 0.2720000 0.4080000
19 0.217 0.116 0.206 0.276 0.074 0.269 0.2740000 0.3520000
76 0.028 0.009 0.028 0.032 0.007 0.033 0.2780000 0.6060000
98 0.453 0.088 0.456 0.498 0.064 0.515 0.2790000 0.3000000
184 0.058 0.023 0.053 0.046 0.015 0.049 0.2890000 0.2520000
132 0.275 0.063 0.291 0.246 0.031 0.258 0.2900000 0.3000000
160 0.013 0.002 0.013 0.015 0.004 0.016 0.2990000 0.3520000
210 0.016 0.001 0.016 0.019 0.007 0.016 0.3020000 0.6800000
188 0.200 0.035 0.205 0.179 0.044 0.200 0.3130000 0.4080000
(Continued)
Proteomics Insights 2011:4 45


http://www.la-press.com

2

Natale et al
(Continued)
Control Control Control Infarction Infarction Infartion T test Wilcoxon
mean St_Dev median mean St_Dev median P-value P-value
7 0.039 0.016 0.042 0.046 0.014 0.049 0.3260000 0.2520000
31 0.023 0.009 0.026 0.027 0.007 0.029 0.3380000 0.2520000
70 0.207 0.073 0.195 0.241 0.062 0.229 0.3380000 0.3000000
203 0.025 0.004 0.025 0.034 0.027 0.026 0.3400000 1.0000000
230 0.278 0.257 0.192 0.421 0.326 0.229 0.3440000 0.1740000
45 0.224 0.237 0.136 0.132 0.031 0.121 0.3470000 0.6060000
66 0.405 0.052 0.394 0.377 0.063 0.396 0.3480000 0.5360000
212 0.009 0.001 0.009 0.010 0.003 0.009 0.3490000 0.5360000
10 0.114 0.057 0.122 0.137 0.025 0.141 0.3510000 0.4080000
67 1.791 0.326 1.845 1.975 0.436 1.851 0.3510000 0.4080000
57 0.016 0.007 0.015 0.013 0.004 0.013 0.3520000 0.4080000
130 0.090 0.012 0.090 0.083 0.015 0.089 0.3530000 0.6060000
164 0.043 0.004 0.046 0.045 0.007 0.045 0.3560000 0.4700000
11 0.101 0.050 0.107 0.121 0.026 0.118 0.3580000 0.4700000
82 0.019 0.018 0.013 0.012 0.002 0.012 0.3620000 0.5360000
27 0.005 0.001 0.005 0.005 0.001 0.005 0.3650000 0.3000000
117 0.238 0.063 0.243 0.280 0.115 0.259 0.3660000 0.6800000
65 0.239 0.076 0.249 0.268 0.031 0.264 0.3700000 0.4700000
204 0.062 0.014 0.068 0.055 0.020 0.056 0.3700000 0.4700000
64 0.105 0.029 0.097 0.116 0.012 0.115 0.3760000 0.3520000
96 0.230 0.042 0.223 0.246 0.027 0.245 0.3880000 0.2520000
8 0.055 0.025 0.061 0.066 0.019 0.069 0.3930000 0.4080000
55 37.791 2.655 38.727 39.108 3.319 39.207 0.3930000 0.6800000
9 0.091 0.045 0.097 0.108 0.025 0.120 0.3940000 0.3520000
214 1.888 0.160 1.946 1.793 0.271 1.846 0.3960000 0.3520000
33 0.068 0.026 0.075 0.078 0.014 0.077 0.3970000 0.6060000
201 0.020 0.006 0.019 0.026 0.019 0.020 0.3980000 0.7580000
53 0.015 0.005 0.012 0.017 0.005 0.017 0.4050000 0.5360000
221 0.153 0.019 0.149 0.143 0.030 0.135 0.4090000 0.1140000
13 0.036 0.031 0.024 0.049 0.032 0.036 0.4110000 0.4080000
56 0.023 0.009 0.024 0.019 0.007 0.018 0.4110000 0.4080000
227 0.457 0.236 0.447 0.364 0.191 0.370 0.4110000 0.6060000
80 0.177 0.048 0.165 0.160 0.021 0.161 0.4120000 0.5360000
104 0.043 0.007 0.044 0.040 0.007 0.041 0.4130000 0.3520000
151 0.300 0.162 0.246 0.244 0.082 0.226 0.4270000 0.5360000
12 0.087 0.042 0.084 0.101 0.021 0.101 0.4320000 0.3520000
89 0.066 0.031 0.053 0.056 0.017 0.050 0.4360000 0.3520000
209 0.018 0.001 0.018 0.020 0.006 0.018 0.4390000 1.0000000
232 0.043 0.056 0.021 0.026 0.011 0.022 0.4510000 0.6800000
94 0.667 0.141 0.668 0.716 0.102 0.767 0.4520000 0.4700000
51 0.128 0.057 0.126 0.109 0.039 0.112 0.4540000 0.5360000
114 1.760 0.348 1.904 1.873 0.238 1.887 0.4780000 0.6800000
26 0.049 0.019 0.043 0.043 0.012 0.043 0.4800000 0.7580000
208 0.211 0.034 0.206 0.223 0.032 0.227 0.4820000 0.6060000
72 0.085 0.032 0.083 0.095 0.016 0.091 0.4850000 0.2520000
38 0.005 0.002 0.005 0.004 0.001 0.004 0.4890000 0.9180000
108 1.147 0.336 1.278 1.253 0.226 1.254 0.4890000 0.7580000
(Continued)
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(Continued)
Control Control Control Infarction Infarction Infartion T test Wilcoxon
mean St_Dev median mean St_Dev median P-value P-value
77 0.897 0.118 0.914 0.951 0.195 0.937 0.5030000 0.6800000
197 0.014 0.004 0.015 0.013 0.002 0.013 0.5060000 0.4700000
207 0.019 0.004 0.019 0.018 0.005 0.017 0.5080000 0.5360000
34 0.050 0.020 0.062 0.056 0.013 0.058 0.5180000 0.6800000
125 0.044 0.006 0.047 0.046 0.006 0.045 0.5210000 0.8380000
156 0.026 0.005 0.025 0.032 0.026 0.022 0.5220000 0.5360000
88 0.296 0.091 0.265 0.273 0.033 0.272 0.5290000 1.0000000
218 1.225 0.365 1.215 1.125 0.192 1.101 0.5290000 0.6060000
18 0.132 0.065 0.133 0.150 0.035 0.150 0.5370000 0.7580000
153 0.018 0.004 0.016 0.016 0.003 0.017 0.5370000 0.4700000
206 0.207 0.056 0.196 0.189 0.052 0.193 0.5370000 0.6060000
158 0.205 0.044 0.186 0.222 0.061 0.234 0.5380000 0.3000000
155 0.107 0.025 0.098 0.099 0.024 0.102 0.5470000 0.7580000
93 0.954 0.218 0.873 1.014 0.153 1.101 0.5520000 0.5360000
190 0.015 0.005 0.015 0.016 0.005 0.015 0.5550000 0.7580000
92 0.195 0.084 0.164 0.175 0.024 0.169 0.5580000 0.8380000
32 0.046 0.016 0.051 0.050 0.013 0.056 0.5610000 0.4080000
116 0.074 0.008 0.074 0.078 0.020 0.081 0.5640000 0.4080000
225 1.178 0.652 1.517 0.993 0.659 1.110 0.5840000 0.7580000
52 0.010 0.004 0.008 0.012 0.005 0.011 0.5910000 0.6060000
24 0.025 0.009 0.023 0.022 0.005 0.023 0.5920000 0.7580000
87 0.215 0.070 0.204 0.199 0.040 0.190 0.5960000 0.6800000
176 0.220 0.029 0.227 0.231 0.051 0.216 0.5980000 0.8380000
120 0.164 0.039 0.160 0.154 0.031 0.139 0.6020000 0.5360000
14 0.057 0.026 0.055 0.062 0.011 0.062 0.6030000 0.6060000
71 0.699 0.071 0.686 0.675 0.110 0.684 0.6070000 0.6800000
23 0.081 0.025 0.084 0.087 0.014 0.085 0.6180000 0.5360000
191 0.011 0.003 0.011 0.012 0.003 0.012 0.6200000 0.6800000
140 0.075 0.051 0.046 0.063 0.040 0.038 0.6240000 0.9180000
187 0.131 0.037 0.127 0.141 0.035 0.150 0.6280000 0.5360000
75 1.820 0.202 1.802 1.741 0.450 1.728 0.6470000 0.9180000
16 0.044 0.018 0.048 0.047 0.008 0.046 0.6480000 1.0000000
37 0.053 0.013 0.054 0.051 0.009 0.049 0.6480000 0.4700000
167 0.076 0.020 0.079 0.081 0.019 0.082 0.6480000 0.4700000
222 0.059 0.018 0.054 0.063 0.011 0.058 0.6480000 0.3000000
68 0.230 0.072 0.238 0.244 0.034 0.240 0.6540000 0.8380000
194 0.041 0.011 0.041 0.044 0.010 0.043 0.6570000 0.6060000
217 2.982 0.719 3.044 2.837 0.501 2.737 0.6580000 0.6060000
91 0.142 0.068 0.115 0.130 0.023 0.129 0.6600000 0.6060000
181 0.392 0.109 0.425 0.368 0.100 0.343 0.6600000 0.6800000
192 0.025 0.007 0.023 0.026 0.006 0.026 0.6630000 0.5360000
126 1.043 0.241 1.040 0.996 0.177 1.068 0.6700000 1.0000000
84 0.024 0.005 0.024 0.025 0.005 0.023 0.6720000 1.0000000
106 0.403 0.071 0.395 0.388 0.064 0.412 0.6720000 0.7580000
97 1.123 0.287 1.052 1.175 0.179 1.200 0.6840000 0.5360000
83 0.012 0.002 0.012 0.011 0.002 0.010 0.6860000 0.9180000
152 0.430 0.111 0.394 0.411 0.066 0.391 0.6920000 0.9180000
(Continued)
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(Continued)
Control Control Control Infarction Infarction Infartion T test Wilcoxon
mean St_Dev median mean St_Dev median P-value P-value
161 0.090 0.032 0.071 0.096 0.031 0.099 0.6970000 0.7580000
119 0.822 0.194 0.750 0.854 0.093 0.856 0.7060000 0.2100000
105 0.541 0.229 0.496 0.578 0.134 0.574 0.7090000 0.5360000
185 0.042 0.007 0.041 0.043 0.010 0.042 0.7090000 0.6800000
61 0.120 0.020 0.123 0.116 0.022 0.120 0.7140000 0.9180000
220 0.112 0.022 0.116 0.118 0.040 0.127 0.7140000 0.8380000
134 0.142 0.117 0.074 0.121 0.116 0.085 0.7300000 0.7580000
202 0.111 0.039 0.104 0.117 0.021 0.113 0.7310000 0.8380000
99 1.134 0.315 1.046 1.182 0.207 1.137 0.7350000 0.3520000
50 0.022 0.007 0.022 0.021 0.007 0.021 0.7400000 0.6060000
162 0.589 0.144 0.523 0.620 0.233 0.657 0.7430000 0.9180000
85 0.038 0.012 0.035 0.037 0.008 0.033 0.7500000 0.9180000
101 0.014 0.004 0.014 0.014 0.002 0.014 0.7530000 0.9180000
28 0.035 0.012 0.037 0.033 0.011 0.030 0.7660000 1.0000000
100 0.032 0.016 0.029 0.034 0.008 0.033 0.7840000 0.1740000
186 0.022 0.008 0.022 0.023 0.007 0.024 0.7850000 0.6060000
211 0.016 0.001 0.016 0.017 0.002 0.016 0.7850000 0.9180000
90 0.283 0.092 0.245 0.273 0.042 0.269 0.7940000 0.8380000
128 0.807 0.130 0.812 0.825 0.142 0.866 0.7960000 0.6800000
213 0.059 0.018 0.060 0.057 0.012 0.057 0.7980000 0.9180000
145 0.030 0.017 0.022 0.032 0.013 0.027 0.8040000 0.4700000
17 0.064 0.029 0.070 0.067 0.014 0.062 0.8120000 0.9180000
95 0.154 0.059 0.134 0.160 0.033 0.154 0.8180000 0.3520000
196 0.030 0.009 0.028 0.029 0.009 0.033 0.8190000 0.6800000
169 1.648 0.335 1.560 1.601 0.500 1.717 0.8260000 1.0000000
148 0.010 0.004 0.009 0.010 0.004 0.010 0.8560000 0.7580000
205 0.025 0.009 0.024 0.024 0.004 0.024 0.8710000 0.6800000
59 0.416 0.120 0.431 0.424 0.064 0.406 0.8750000 0.6060000
63 0.005 0.001 0.005 0.005 0.001 0.005 0.8780000 1.0000000
62 0.087 0.017 0.084 0.086 0.011 0.088 0.8870000 0.9180000
109 0.012 0.002 0.011 0.012 0.002 0.012 0.9250000 1.0000000
179 0.133 0.020 0.137 0.131 0.030 0.133 0.9270000 0.9180000
127 0.715 0.125 0.745 0.719 0.1 0.689 0.9410000 1.0000000
216 0.015 0.006 0.013 0.015 0.004 0.014 0.9420000 0.8380000
174 0.372 0.024 0.375 0.373 0.048 0.359 0.9480000 1.0000000
69 0.036 0.014 0.039 0.036 0.007 0.033 0.9580000 0.8380000
112 0.158 0.021 0.153 0.157 0.044 0.159 0.9610000 0.7580000
193 0.040 0.010 0.042 0.040 0.009 0.041 0.9610000 0.9180000
171 1.646 0.348 1.625 1.655 0.481 1.882 0.9660000 0.5360000
189 0.160 0.065 0.154 0.158 0.037 0.170 0.9660000 0.6060000
226 0.229 0.112 0.242 0.226 0.197 0.139 0.9660000 0.7580000
166 1.161 0.242 1.068 1.155 0.439 1.272 0.9730000 0.8380000
198 0.035 0.009 0.035 0.035 0.008 0.032 0.9760000 1.0000000
49 0.216 0.067 0.231 0.215 0.035 0.221 0.9800000 0.7580000
81 0.014 0.003 0.014 0.014 0.003 0.014 0.9810000 1.0000000
113 0.094 0.022 0.084 0.094 0.020 0.096 0.9820000 0.6800000
175 1.092 0.274 1.065 1.089 0.311 1.055 0.9830000 1.0000000
(Continued)
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(Continued)
Control Control Control Infarction Infarction Infartion T test Wilcoxon
mean St_Dev median mean St_Dev median P-value P-value
180 0.077 0.011 0.080 0.077 0.012 0.080 0.9830000 0.9180000
36 0.036 0.011 0.036 0.036 0.008 0.035 0.9950000 1.0000000
138 0.489 0.104 0.431 0.489 0.109 0.447 0.9970000 0.7580000
35 0.020 0.009 0.015 0.020 0.007 0.018 0.9980000 0.8380000
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